SIMATIC Safety Integrated for Factory Automation

Fail-Safe Drives

SINAMICS G120 (FW3.2)

Controlled via Profibus, safety functions via terminals
Category 3 (EN 954-1), SIL 2 (IEC 61508) and PLd (ISO 13849-1)
Preliminary remark

The Functional Examples dealing with “Safety Integrated” are fully functional and tested automation configurations based on A&D standard products for simple, fast and inexpensive implementation of automation tasks in safety engineering. Each of these Functional Examples covers a frequently occurring subtask of a typical customer problem in safety engineering.

Aside from a list of all required software and hardware components and a description of the way they are connected to each other, the Functional Examples include the tested and commented code. This ensures that the functionalities described here can be reset in a short period of time and thus also be used as a basis for individual expansions.

Important note

The Safety Functional Examples are not binding and do not claim to be complete regarding the circuits shown, equipping and any eventuality. The Safety Functional Examples do not represent customer-specific solutions. They are only intended to provide support for typical applications. You are responsible for ensuring that the described products are used correctly.

These Safety Functional Examples do not relieve you of the responsibility of safely and professionally using, installing, operating and servicing equipment. When using these Safety Functional Examples, you recognize that Siemens cannot be made liable for any damage/claims beyond the liability clause described. We reserve the right to make changes to these Safety Functional Examples at any time without prior notice. If there are any deviations between the recommendations provided in these Safety Function Examples and other Siemens publications – e.g. Catalogs – the contents of the other documents have priority.
List of contents

1 Warranty, Liability and Support .......................................................... 5
2 Automation function ................................................................. 6
  2.1 Description of the functionality ........................................... 6
  2.2 Expanded functionality from firmware V3.2 onwards ........... 7
2.3 Functionality of the function example ...................................... 8
  2.3.1 Task description .......................................................... 8
  2.3.2 Solution ................................................................. 8
  2.4 Advantages / customer benefits ............................................ 8
  2.5 Structure of the function example ...................................... 8
  2.6 Restrictions .................................................................. 9
3 Components that are required .................................................... 10
  3.1 Hardware components .................................................... 10
  3.2 Software components .................................................. 10
4 Configuration and wiring .............................................................. 11
  4.1 Overview of the hardware configuration ................................ 11
  4.2 Connecting-up the hardware components .................. 12
  4.3 Fault 395 (acceptance test / acknowledgement present) ....... 14
  4.4 Important hardware component settings.............................. 15
  4.4.1 SM374 simulation module ....................................... 15
  4.4.2 SINAMICS G120 .................................................... 16
  4.5 Overview of inputs and outputs ....................................... 17
  4.5.1 Simulation module SM374 ....................................... 17
  4.5.2 SINAMICS G120 .................................................... 18
  4.6 Download .................................................................. 19
  4.6.1 S7 program .......................................................... 19
  4.6.2 SINAMICS G120 configuration ................................ 19
    4.6.2.1 Safety functions ............................................. 21
    4.6.2.2 "Enables" tab .............................................. 22
    4.6.2.3 "Safe Torque Off" (STO) tab ................................ 23
    4.6.2.4 "Safe Stop 1" (SS1) tab .................................... 25
    4.6.2.5 Safely Limited Speed (SLS) tab ......................... 26
    4.6.2.6 Accepting settings .......................................... 32
    4.6.2.7 Exiting the STARTER parameterizing software ....... 32
  4.6.3 Function test ........................................................... 33
  4.6.4 Acceptance test and acceptance report .......................... 35
5 Key performance data of the SIMATIC CPU ................................. 36
6 Example code ............................................................................ 37
  6.1 Settings in the hardware configuration ................................. 37
    6.1.1 Properties of the SINAMICS G120 ....................... 38
      6.1.1.1 Standard Telegram ............................................ 40
    6.2 Functions of the Step 7 program .................................... 41
      6.2.1 Program overview ............................................. 41
      6.2.2 DB1, Axis_DB .................................................. 42
      6.2.3 FB10, Organization ............................................ 43
      6.2.4 FC100, Control of SINAMICS G120 .................. 43
      6.3 SINAMICS G120 - parameterization the safety functions ... 44
      6.4 SINAMICS G120 parameterization ............................ 44
      6.4.1 SIMATIC Manager - inserting SINAMICS G120 .... 44
      6.4.2 Calling the STARTER parameterization tool .......... 46
      6.4.3 STARTER - carrying out quick commissioning ......... 46
      6.4.4 STARTER - carrying out a motor identification routine .. 47
      6.4.5 STARTER - setting the Profibus communications ....... 48

<table>
<thead>
<tr>
<th></th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Evaluation according to IEC 62061 and ISO 13849-1</td>
<td>50</td>
</tr>
<tr>
<td>8</td>
<td>Appendix</td>
<td>51</td>
</tr>
<tr>
<td>8.1</td>
<td>Reference data</td>
<td>51</td>
</tr>
<tr>
<td>8.2</td>
<td>Internet link data</td>
<td>51</td>
</tr>
<tr>
<td>8.3</td>
<td>History</td>
<td>51</td>
</tr>
<tr>
<td>8.4</td>
<td>Evaluation / feedback</td>
<td>52</td>
</tr>
</tbody>
</table>
1 Warranty, Liability and Support

We accept no liability for information contained in this document.

Any claims against us – based on whatever legal reason – resulting from the use of the examples, information, programs, engineering and performance data etc., described in this Safety Functional Example shall be excluded. Such an exclusion shall not apply in the case of mandatory liability, e.g. under the German Product Liability Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of a product, fraudulent concealment of a deficiency or breach of a condition which goes to the root of the contract (“wesentliche Vertragspflichten”). However, claims arising from a breach of a condition which goes to the root of the contract shall be limited to the foreseeable damage which is intrinsic to the contract, unless caused by intent or gross negligence or based on mandatory liability for injury of life, body or health. The above provisions do not imply a change in the burden of proof to your detriment.

Copyright © 2010 Siemens A&D. It is not permissible to transfer or copy these Application Examples or excerpts of them without first having prior authorization from Siemens A&D in writing.

For questions about this document please use the following e-mail-address:

Online-support.automation@siemens.com
2 Automation function

2.1 Description of the functionality

The SINAMICS G120 drive inverter is a modular inverter system with degree of protection IP20. It comprises the two function units Control Unit (CU) and Power Module (PM).

When using the Control Unit CU240S DP-F or CU240S PN-F, you have access to the following safety functions that are integrated in the drive inverter:

<table>
<thead>
<tr>
<th>Designation</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STO</td>
<td>Safe Torque Off (acc. to EN60204)</td>
<td>The drive is safely brought into a no-torque condition. Prevents the drive from accidentally starting. Preventing a restart does not require electrical isolation between the motor and drive inverter.</td>
</tr>
<tr>
<td>SS1</td>
<td>Safe Stop 1 (acc. to EN60204)</td>
<td>The drive is quickly stopped and safely monitored. Independent and continuous monitoring guarantees the shortest response times when a fault occurs. A speed encoder is not required.</td>
</tr>
<tr>
<td>SLS</td>
<td>Safely Limited Speed (acc. to EN60204)</td>
<td>The drive speed is limited and monitored. Independent and continuous monitoring guarantees the shortest response times when a fault occurs. A speed encoder is not required.</td>
</tr>
<tr>
<td>SBC</td>
<td>Safe Brake Control</td>
<td>An 24V external brake is safely controlled. In this case, it is necessary to use the Safe Brake Relay.</td>
</tr>
</tbody>
</table>

All safety functions are certified according to EN 954-1 (Cat. 3), IEC 61508 (SIL 2) and ISO 13849-1 (Pl d).

The safety functions are either controlled through two fail-safe digital inputs (4 digital inputs, which are evaluated through 2 channels in a fail-safe fashion in the CU 240S DP F) or via PROFIsafe in conjunction with a fail-safe CPU.
2.2 Expanded functionality from firmware V3.2 onwards

With firmware V3.2, the safety functions of SINAMICS G120 have been expanded as follows:

- The SLS safety function has been expanded by mode 3 (refer to Chapter 4.6.2.5):
  - Using this mode it is possible to start the motor with SLS activated. This means that the motor speed/velocity can be safely monitored / limited from the start.
  - Further, when SLS is activated it is possible to operate with a frequency below 1Hz for a maximum of 5s.
  - Reversing operation is possible when SLS is activated.
- The acknowledgement of F395 has been significantly simplified (an acceptance test is required) (refer to Chapter 4.3).
2.3 Functionality of the function example

2.3.1 Task description

The SINAMICS G120 is to be controlled from an S7-300 CPU via Profinet.
The integrated safety functions of the SINAMICS G120 are to be controlled via the fail-safe digital inputs of the SINAMICS G120.

2.3.2 Solution

In this function example, the control of a SINAMICS G120 (control word and frequency setpoint) will be demonstrated using an S7-300 CPU and a specific program example.
This program example comprises an S7 program to control the SINAMICS G120 and the appropriate configuration in the SINAMICS G120.

2.4 Advantages / customer benefits

The safety functions are integrated in the drive inverter and are implemented without any speed feedback signal. This means that to some extent complex external shutdown and monitoring devices can be eliminated.
A SINAMICS G120 with Safety Control Unit can replace an existing drive inverter. This means that safety functions can be added to an existing system with low associated costs and expenditure.

2.5 Structure of the function example

The download and test of the program examples supplied are described in Chapters 3 to 5.
More in-depth information is provided in Chapter 6 – together with a description of the steps necessary to commission the SINAMICS G120 - so that you can engineer and implement your own projects.
2.6 Restrictions

![Caution]

Please take careful note that the two safety functions SLS and SS1 may not be used for loads that can drive the motor or loads that are continually in the regenerative mode.

Elevating platforms, winders, wind turbines are examples of such loads that can drive motor or continually regenerate into the line supply.

An important prerequisite when using fail-safe functions is that the closed-loop control functions absolutely perfectly. The drive (system comprising the drive inverter + motor + driven load) must be engineered so that all operating situations of the particular application are always completely under control.

![Caution]

After the STO and SS1 safety functions have been activated there is no electrical isolation between the line power supply of the SINAMICS G120 and the motor. If this electrical isolation is required in your particular application, then you must install an appropriate line contactor upstream of the SINAMICS G120.
3 Components that are required

An overview of the hardware and software components required for the function example is provided in the Chapter.

3.1 Hardware components

<table>
<thead>
<tr>
<th>Component</th>
<th>Type</th>
<th>Order No./ordering data</th>
<th>Qty</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7 control</td>
<td></td>
<td></td>
<td></td>
<td>SIEMENS</td>
</tr>
<tr>
<td>Power supply</td>
<td>PS307 5A</td>
<td>6ES7307-1EA00-0AA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>S7-CPU</td>
<td>CPU 315-2DP</td>
<td>6ES7315-2EH13-0AB0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Memory Card</td>
<td>MMC 512KB</td>
<td>6ES7953-8LJ11-0AA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>DI / DO simulation module</td>
<td>SM374</td>
<td>6ES7374-2XH01-0AA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Profile rail</td>
<td>Profile rail</td>
<td>6ES7390-1AE80-0AA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Profibus connector</td>
<td>Profibus connector</td>
<td>6ES7972-0BB50-0XA0</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Profibus cable</td>
<td>Profibus cable</td>
<td>6XV1830-3BH10</td>
<td>2 m</td>
<td></td>
</tr>
<tr>
<td>Drive</td>
<td></td>
<td></td>
<td></td>
<td>SIEMENS</td>
</tr>
<tr>
<td>SINAMICS G120 Control Unit *</td>
<td>CU240S DP F</td>
<td>6SL3244-0BA21-1PA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>SINAMICS G120 Power Module *</td>
<td>PM240</td>
<td>6SL3224-0BE21-5UA0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Basic Operator Panel *</td>
<td>BOP</td>
<td>6SL3255-0AA00-4BA1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Motor *</td>
<td>Three-phase induction</td>
<td>1LA7060-4AB10</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Command devices</td>
<td></td>
<td></td>
<td></td>
<td>SIEMENS</td>
</tr>
<tr>
<td>Empty enclosure *</td>
<td>Empty enclosure with 2</td>
<td>3SB3802-0AA3</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Emergency Stop mushroom pushbutton (to activate SS1) *</td>
<td>Emergency Stop mushroom pushbutton</td>
<td>3SB3000-1HA20</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Mushroom pushbutton (to activate SLS) *</td>
<td>Mushroom pushbutton, red</td>
<td>3SB3000-1DA21</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Contact *</td>
<td>1NC, screw terminal</td>
<td>3SB3420-0C</td>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

As an alternative to the components marked with *, the SINAMICS G120 training case can also be used that is additionally equipped with a 24V HTL encoder and a mechanical brake. This training case can be ordered by specifying Order No. 6ZB2480-0CD00.

Note

The functionality was tested with the specified hardware components. Similar components that are different from those listed above can be used. Please note that in such a case it may be necessary to change the code example (e.g. setting other addresses).

3.2 Software components

<table>
<thead>
<tr>
<th>Component</th>
<th>Version</th>
<th>Order No. / ordering data</th>
<th>Qty</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC STEP 7</td>
<td>V5.4 + SP5 + HF1</td>
<td>6ES7810-4CC08-0YA5</td>
<td>1</td>
<td>SIEMENS</td>
</tr>
<tr>
<td>STARTER</td>
<td>V4.1 + SP5 + HF1</td>
<td><a href="http://support.automation.siemens.com/WW/view/en/26233208">http://support.automation.siemens.com/WW/view/en/26233208</a></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>GSD-File CU240S DP-F</td>
<td>V3.2</td>
<td><a href="http://support.automation.siemens.com/WW/view/en/23450838">http://support.automation.siemens.com/WW/view/en/23450838</a></td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
4 Configuration and wiring

The hardware configuration and connecting-up the function example are described in this Chapter.

Please carefully observe the following safety information & instructions when using the SINAMICS G120:

![Warning]

The SINAMICS G120 has hazardous voltages and controls rotating mechanical parts that can also be potentially hazardous. If the warning information is not observed or the information & instructions from the instructions belonging to SINAMICS G120 are not complied with this could result in death, severe bodily injury or significant material damage.

4.1 Overview of the hardware configuration
4.2 Connecting-up the hardware components

4.2.1 S7-300 control and CU240S DP-F
4.2.2 PM240 and motor

For more detailed information regarding the installation please refer to the SINAMICS G120 Hardware Installation Manual Power Module PM240. Download from: http://support.automation.siemens.com/WW/view/en/22339653/133300
4.3 Fault 395 (acceptance test / acknowledgement present)

Fault F395 is output when powering-up for the first time and after replacing the Control Unit (CU) or the Power Module (PM).

This fault does not represent an incorrect drive inverter function. The reason for this fault message is to monitor the individual drive inverter components (CU and PM) to prevent them from being replaced by unauthorized personnel.

Acknowledging fault F395 beginning with firmware V3.2

The acknowledgment of F395 has been significantly simplified with the introduction of firmware V3.2. Just like any other fault, it can be acknowledged using an appropriately parameterized input, via the field bus or using the STARTER parameterizing software.

Acknowledging fault F395 with older firmware versions (<V3.2)

To acknowledge the F395 in conjunction with older firmware versions, proceed as follows:

- Set parameter p0010 to 30
- Enter the safety password (standard = 12345) into parameter p9761
- Set parameter p7844 to 0
- F395 will no longer be displayed

Next steps

The user must then carry-out an acceptance test/check. More information is provided in the G120 Operating Instructions in Chapter Appendix under Acceptance Log.


4.4 Important hardware component settings

Most of the module/board settings are made in the HW Config in the software. Hardware settings are only required for the following modules/boards.

The modules/boards must be set with the control system in a no-voltage state.

4.4.1 SM374 simulation module

This module can be operated as 16 x DO (output via LED), 16 x DI (input via switch) or as combined 8 x DI / 8 x DO. The last combination is used in this function description.

The function of the module is selected using a rotary switch behind the front cover between the series of switches.

As shown in the following diagram set the function switches to the setting **8 x Output 8 x Input**.
4.4.2 SINAMICS G120

The Profibus address must be set on the right-hand side of the Control Unit according to HW Config.

Using the DIL switch, set address 10 as shown in the following diagram.
4.5 Overview of inputs and outputs

4.5.1 Simulation module SM374

<table>
<thead>
<tr>
<th>Address</th>
<th>Function</th>
<th>Symbolic address</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>O 0.0</td>
<td>Indicator lamp error</td>
<td>error</td>
<td>0</td>
<td>faults are signaled via this output</td>
</tr>
<tr>
<td>I 0.0</td>
<td>SINAMICS G120 start</td>
<td>Start_G120</td>
<td>0</td>
<td>The motor connected to SINAMICS G120 is started by activating the input</td>
</tr>
<tr>
<td>I 0.1</td>
<td>SINAMICS G120 reverse</td>
<td>Reverse_G120</td>
<td>0</td>
<td>After the input is activated, a negative frequency setpoint is entered (direction of rotation reversal)</td>
</tr>
<tr>
<td>I 0.5</td>
<td>Increase frequency</td>
<td>Increase_frequency</td>
<td>0</td>
<td>The motor frequency can be increased using this input</td>
</tr>
<tr>
<td>I 0.6</td>
<td>Decrease frequency</td>
<td>Decrease_frequency</td>
<td>0</td>
<td>The motor frequency can be reduced using this input</td>
</tr>
<tr>
<td>I 0.7</td>
<td>Acknowledge error</td>
<td>ACK_error</td>
<td>0</td>
<td>Fault messages that are present can be acknowledged using this input</td>
</tr>
</tbody>
</table>
### 4.5.2 SINAMICS G120

The SINAMICS G120 is controlled and the feedback signals read-in via the I/O addresses listed below.

<table>
<thead>
<tr>
<th>Address</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>PQW256</td>
<td>Control word 1</td>
</tr>
<tr>
<td>PQW258</td>
<td>Frequency setpoint</td>
</tr>
<tr>
<td>PQW260</td>
<td>Torque setpoint</td>
</tr>
<tr>
<td>PQW262</td>
<td>Control word 2</td>
</tr>
<tr>
<td>PQW264</td>
<td>-- Reserve --</td>
</tr>
<tr>
<td>PQW266</td>
<td>-- Reserve --</td>
</tr>
</tbody>
</table>

#### S7 program -> SINAMICS G120

<table>
<thead>
<tr>
<th>Address</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIW256</td>
<td>Status word 1</td>
</tr>
<tr>
<td>PIW258</td>
<td>Frequency actual value</td>
</tr>
<tr>
<td>PIW260</td>
<td>Current actual value</td>
</tr>
<tr>
<td>PIW262</td>
<td>Status word 2</td>
</tr>
<tr>
<td>PIW264</td>
<td>Last fault number</td>
</tr>
<tr>
<td>PIW266</td>
<td>Last alarm number</td>
</tr>
</tbody>
</table>

For more detailed information about the configuration of the individual signals, please refer to *SINAMICS G120 Operating Instructions Control Unit CU240S*, Chapter *Commissioning*.

4.6  Download

4.6.1  S7 program

To download the S7 program, you will require a connection between the MPI interface of your PG/PC and the MPI interface of the S7 CPU.

- Start the SIMATIC Manager.
- De-archive the function example supplied.
- Open the G120_Safety_App2_V20 project.
- Select the PROFIBUS interface parameterization using Options > Select PG/PC interface….
- Open HW-Config and download this into the control. After the download re-close HW-Config.
- In SIMATIC Manager, select the block folder via CPU315F-2 PN/DP > S7 Program > Blocks.
- Download all of the S7 program blocks into the CPU

4.6.2  SINAMICS G120 configuration

When this has been completed, download the SINAMICS G120 configuration using the STARTER parameterizing tool.

- Starting from the main path of the SIMATIC Manager, start the STARTER parameterizing software by selecting the SINAMICS_G120 icon and double click on the Inbetriebnahme icon.

Then, in the Project Navigator of the STARTER parameterizing software select the object “G120” (1.) and press the button (2.) to establish the online connection to the drive inverter.
After you have established the online connection, press the button to download the SINAMICS G120 drive parameters.

Follow the instructions on the screen and acknowledge the prompt "After loading, copy RAM to ROM".

You must then enter the safety parameters of the SINAMICS G120. These may not be - and cannot for safety reasons - be transferred into the drive inverter by downloading from the PG / PC.
4.6.2.1 Safety functions

- In the Project Navigator, select **Functions** and then open the dialog box for the safety functions by double clicking on **Safety Integrated**.

- Then press the button **Change settings** and enter 12345 (standard password) in the password screen that then opens.

- From the following screen forms transfer the appropriate values into your project. Take into consideration that in certain instances there are different value formats for processor 1 and 2 (e.g. s and ms, Hz and kHz). The reason for this, is that for the two processors in the SINAMICS G120, which should operate in parallel and should come to the same result, separate parameter sets are available for safety reasons.
4.6.2.2 "Enables" tab

In this screen form you parameterize the source from which you activate the SINAMICS G120 safety functions. Please note that the safety functions can either be controlled via PROFIsafe or via the safety digital inputs.

- **Upper section**: Path to activate via PROFIsafe.
- **Center section**: Path to activate via the Safe digital input 0 and 1 (this is used in this particular function example).
- **Lower section**: Here, the monitoring of the Safe brake control module can be activated; however, this is not used in this particular function example.

It should be noted that the parameterization is always carried-out twice (in this screen form this can be identified as a result of the two switch symbols in series). The reason for this is that for the two processors in SINAMICS G120 - that operate in parallel and must provide the same result - there are separate parameter sets for safety reasons.

After you have parameterized the enable signals, then select the tab **Safe Torque Off**.
The shutdown paths of a safety-relevant plant or system must be subject to a forced checking procedure at regular intervals. This is in order to identify "dormant" errors. SINAMICS G120 automatically carries out a forced checking procedure of the shutdown paths in the drive unit. This procedure is known as the forced checking procedure.

A reduced form of the forced checking procedure limited to self-test the brakes and processor is always automatically executed after "Safe Torque Off" (STO) is exited. This type of forced checking procedure is known as the process checking procedure.

Further, by appropriately parameterizing the system, it is possible to initiate a forced checking procedure each time that STO is exited.

- **Upper section:** Using **Test of the shutdown channels when leaving STO**, you can select how the forced checking procedure for the shutdown channels is carried-out.
  - **Activated:** A dynamization (forced checking procedure) is carried-out when first powering-up after "Safe Torque Off" (STO). It takes about 2.4s to check the shutdown channels. This delay time should be taken into account for an on command.
  - **Deactivated:** The shutdown channels are only checked after initiating the function "Latched Safe Torque Off" (LSTO) in a fault condition/situation and after switching-out the power supply voltage and switching-in again. When exiting an STO, a delay time is not incurred as only the process checking procedure is carried-out.
Center section: When activating the safety functions via the safe digital inputs of the SINAMICS G120, a debounce time and a filter for the response time can be set here.

Lower section: The SINAMICS G120 automatically monitors when a forced checking procedure was carried-out the last time. Set the time up to the next forced checking procedure in the field Test periods for shutdown paths. The time can be selected between 0.1 and 8760 hours (6 min up to 1 year). The timer is re-started after each forced checking procedure. Alarm A1699 is output in operation to flag you that this monitoring time has expired. A process checking procedure does not replace forced checking procedure and therefore does not reset the timer.

After you have parameterized the Safe Torque Off function, select the tab Safe Stop 1.
4.6.2.4  “Safe Stop 1” (SS1) tab

The parameters relevant for “Safe Stop 1” (SS1) are set in this screen form.

- **(1.)** Using the threshold value **Standstill detection**, define the speed at which standstill (zero speed) is detected and "Safe Torque Off" (STO) is activated. Please note that the value should be entered once in kHz and once in Hz.

- **(2.)** The **Ramp-down time Tr for SS1** ... should then be entered. Please note that the value is entered once in s and once in ms. The ramp-down time Tr always refers to the safety reference frequency of 200Hz in the drive itself. This ramp-down time is also used for the deceleration for "Safely Limited Speed" (SLS).

- **(3.)** The monitoring tolerance is set using **Delay Tv, until monitoring active**. The drive inverter continually monitors - with tolerance Tv - the braking of the drive.

If the tolerance is selected too low, then the monitoring function could be incorrectly tripped. If the tolerance is too high, then if an actual fault does develop, an unnecessarily long time is wasted. Please note that the value is entered once in s and once in ms.

- You can download an Excel tool to calculate SS1 and SLS parameters under the following link: [http://support.automation.siemens.com/WW/view/en/24488874](http://support.automation.siemens.com/WW/view/en/24488874)

After you have parameterized the function **Safe Stop 1**, select the tab **Safely Limited Speed**.
4.6.2.5 Safely Limited Speed (SLS) tab

The parameters relevant for "Safely Limited Speed" are entered in this screen form.

- **1.** The SLS mode is defined here. For this function example set mode 1 (*Activate the braking ramp while* \( f > f_{\text{SLS}} \) (1)).
- The following four modes - with the appropriate properties - are available:
### SLS Mode 0

**Properties**

- **Initiate STO with braking ramp and drive fault when \( f > f_{SLS} (0) \)**
  - Limiting to a safely limited speed
  - The speed can not be changed via frequency setpoint

---

- If, when SLS is activated, the actual frequency is greater than the **Upper SLS limit**, SS1 is activated and then LSTO (safe torque shutdown with latching).

- If, when SLS is activated, the actual frequency lies between the **Upper SLS limit** and the **Setpoint for SLS**, then the **Setpoint for SLS** is activated. The frequency cannot be changed.

- If the actual frequency lies below the **Setpoint for SLS**, the actual frequency is kept. The frequency cannot be changed.

- STO is activated if the actual frequency is below 1Hz.

- SLS can be ended with ON/OFF1, OFF2 and OFF3 – and as a consequence, the drive is stopped. The drive can only be re-started if SLS was withdrawn. In just the same way - SLS is ended by activating STO and SS1.
### SLS Mode Properties

**Activate braking ramp while \( f > f_{\text{SLS}} \) (1)**
- Reducing to a safely limited speed
- The speed cannot be changed via frequency setpoint

<table>
<thead>
<tr>
<th>SLS Mode</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode 1</td>
<td><strong>Activate braking ramp while ( f &gt; f_{\text{SLS}} ) (1)</strong>&lt;br&gt;Reducing to a safely limited speed&lt;br&gt;The speed cannot be changed via frequency setpoint</td>
</tr>
</tbody>
</table>

- If, when activating SLS, the actual frequency is greater than the *Upper SLS limit*, the *Setpoint for SLS* is activated and the drive is braked down to this setpoint using the SS1 safe braking ramp (refer to Safe Stop 1 tab, parameter *Ramp-down time Tr for SS1* ...).
- If the actual frequency lies below the *Setpoint for SLS*, the actual frequency is kept. The frequency cannot be changed.
- STO is activated if the actual frequency is below 1Hz.
- SLS can be ended with ON/OFF1, OFF2 and OFF3 – and as a consequence, the drive is stopped. The drive can only be re-started if SLS was withdrawn. In just the same way - SLS is ended by activating STO and SS1.
SLS Mode 2

*Initiate STO without braking ramp and with drive fault while \( f > f_{SLS} \)*

Limiting to a safely limited speed

The speed can be changed via frequency setpoint

- If, when activating SLS, the actual frequency is greater than the *Upper SLS limit*, LSTO (safe torque shutdown with latching) is activated.
- If, when activating SLS, the actual frequency lies below the *Upper SLS limit*, the frequency is kept. The frequency can be changed between 1 Hz and the *Upper SLS limit* (Caution: For V/f, take into account the slip compensation).
- If the actual frequency drops below 1Hz or the *Upper SLS limit* is reached, STO is activated. If the upper tolerance limit for velocity monitoring is exceeded, then STO is latched – i.e. LSTO.
- SLS can be ended with ON/OFF1, OFF2 and OFF3 – and as a consequence, the drive is stopped. The drive can only be re-started if SLS was withdrawn. In just the same way - SLS is ended by activating STO and SS1.
SINAMICS G120; Safety functions via terminals

<table>
<thead>
<tr>
<th>SLS Mode</th>
<th>Properties</th>
</tr>
</thead>
</table>
| Mode 3   | **SLS with ramp down from 0Hz (3)**
          | Start with active SLS, limit to a safely-limited speed. It is possible to vary the speed via the setpoint input. The speed can be reduced to 0Hz and reversing operation is possible. |

- If SLS is activated at standstill, then the frequency inverter must be started within 5s and a frequency of 1Hz must be exceeded. Otherwise, the frequency inverter switches into the safe state with STO. If the frequency setpoint that has been entered lies above the **Upper SLS limit**, LSTO (Safe Torque Off with latching) is activated.
- In JOG-Mode with activated SLS please ensure that the drive frequency reaches 1Hz within 5s. Otherwise upon the 3rd activation of SLS the drive will switched off with LSTO and error F1614 (additional info 105 / 205).
- If, when activating SLS, the actual frequency is higher than the **Upper SLS limit**, LSTO (Safe Torque Off with latching) is activated.
- If, when activating SLS, the actual frequency is below the **Upper SLS limit**, then the frequency is kept. The frequency can be varied between 0Hz and the **Upper SLS limit** (caution, for V/f control take into account the slip compensation). However, the frequency range below 1Hz must be again exited within 5s - otherwise the frequency inverter will shut down (trip) with STO.
- In reversing operation, the frequency range between +/- 1Hz must be passed through within 5s - otherwise the frequency inverter will shutdown (trip) with STO.
- With ON/OFF1, OFF2 und OFF3 the drive can be stopped. In addition SLS needs to be deactivated manually. For example after deactivation of ON/OFF1 with active SLS the drive can only be started after a deactivation of SLS and if necessary reactivation of SLS.
- SLS is also ended by activating STO and SS1.
You can obtain more detailed information about the SLS modes from the Function Manual SINAMICS G120, SINAMICS G120D, SIMATIC ET200S FC, SIMATIC ET200pro FC in Chapter Fail-Safe Functions under Safely Limited Speed. Download from: http://support.automation.siemens.com/WW/view/en/25021636/133300

- **(2.)** These input fields are displayed only for SLS mode 0 and 1. **Setpoint for SLS** is used to set the frequency to which the frequency setpoint is internally limited in the drive unit after the function Safely Limited Speed SLS has been selected. Please note that the value is entered once in Hz and once in kHz.

- **(3.)** The monitoring limit is set using the **Upper SLS limit**. If Safely Limited Speed SLS is active and the actual frequency exceeds this value, then SINAMICS G120 outputs a fault message and goes into the safe condition (Safe Torque Off, STO). Please note that the value should be entered once in Hz and once in kHz.

- You can download an Excel tool to calculate SS1 and SLS parameters under the following link: http://support.automation.siemens.com/WW/view/en/24488874
4.6.2.6 Accepting settings

- After you have made all of the settings press the Accept settings button.
- You can now change the standard password. If you are still not certain that your safety parameterization has been completed, then you should press the Later button.
  However, after you have completed the commissioning phase, do not forget to change the standard password for a password that only you know or a person that you trust. Only then can you be sure that only authorized persons can change/modify safety parameters.
- To complete the parameterization of the safety functions you must now acknowledge the checksums of the two processors. To do this, transfer the first checksum, processor 1 into the set checksum, processor 1. Do exactly the same for the checksum of processor 2.
  Please note that the two actual checksums and therefore the two set checksums must be the same. If this is not the case, then you must re-check your parameterization of the safety functions and resolve the different values.

4.6.2.7 Exiting the STARTER parameterizing software

- If you don't wish to set any additional parameters, then you can now exit the STARTER commissioning tool.
- In the tree select SINAMICS G120 and transfer all of the parameter changes into the ROM memory of the SINAMICS G120 by pressing the button.
- Then transfer all of the parameters into your offline a project by pressing the button.
- Disconnect the PG / PC from SINAMICS G120 by pressing the button.
- Now you can close STARTER using Project > Close or by pressing the button.
4.6.3 Function test

The function test can be carried-out, if

- The hardware components are connected-up
- The hardware settings have been made
- The S7 project is in the CPU
- The configured software has been downloaded into the SINAMICS G120 and the safety functions have been parameterized
- The CPU is in the RUN state

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>If it is pressed, release the Emergency Stop pushbutton</td>
<td>The signal lamp (A0.0) for &quot;Error&quot; goes dark.</td>
</tr>
<tr>
<td>2</td>
<td>Press the pushbutton &quot;Acknowledge faults&quot;</td>
<td>The LED RDY, SS1 and SLS are bright -&gt; the drive and all of the safety functions are in the ready state.</td>
</tr>
<tr>
<td>3</td>
<td>Press the switch &quot;SINAMICS G120 Start&quot;</td>
<td>The motor starts to run.</td>
</tr>
<tr>
<td></td>
<td>Safety function SS1 (Safe Stop 1)</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Press the Emergency Stop pushbutton SS1</td>
<td>The motor follows the parameterized braking ramp down to the minimum frequency and stops.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>At the SINAMICS G120 the LED ES is bright and LED SS1 flashes -&gt; SS1 is active, the motor has been brought into a no-torque condition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>At the SINAMICS G120 alarm A1696 is displayed -&gt; this alarm is displayed as long as the start signal is present.</td>
</tr>
<tr>
<td>2</td>
<td>De-activate the control of the SINAMICS G120 using the switch &quot;SINAMICS G120 Start&quot;.</td>
<td>The alarm A1696 is no longer displayed at the SINAMICS G120.</td>
</tr>
<tr>
<td>3</td>
<td>Release the Emergency Stop pushbutton SS1</td>
<td>At the SINAMICS G120 the LEDs RDY, SS1 and SLS are bright -&gt; the drive and all of the safety functions are in the ready state.</td>
</tr>
<tr>
<td>4</td>
<td>Press the switch &quot;SINAMICS G120 Start&quot;</td>
<td>The motor starts to operate again.</td>
</tr>
<tr>
<td>No.</td>
<td>Action</td>
<td>Response</td>
</tr>
<tr>
<td>-----</td>
<td>-------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 1   | Press the **pushbutton SLS** and keep it pressed | The motor follows the parameterized braking ramp down to the safely limited speed.  
At the SINAMICS G120 the LED **ES** is bright and LED **SLS** flashes - SLS is active, the motor is monitored to ensure that it does not exceed the safely limited speed. |
| 2   | Release **pushbutton SLS** again    | The motor accelerates back to the normal speed.  
At the SINAMICS G120 LEDs **RDY**, **SS1** and **SLS** are bright - the drive and all safety functions are in the ready state. |
4.6.4 Acceptance test and acceptance report

An acceptance test must be carried-out when the machine is commissioned for the first time and also if a completely saved set of the safety-relevant parameters is changed. This procedure is used to verify the safety-relevant parameters. This acceptance test must be appropriately documented. The acceptance reports must be appropriately stored and archived.

The checksum ensures that all subsequently made changes are identified.

Information about the acceptance test are provided in the Operating Instruction Control Unit CU240S in Chapter Appendix under Acceptance Log.

Download from:

Download Acceptance test report from:
5  Key performance data of the SIMATIC CPU

Load memory and working memory

<table>
<thead>
<tr>
<th></th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load memory</td>
<td>Approx. 6 k</td>
</tr>
<tr>
<td>Working memory</td>
<td>Approx. 2 k</td>
</tr>
</tbody>
</table>

Cycle time

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Total cycle time (typical)</td>
<td>Approx. 1ms</td>
</tr>
<tr>
<td>Standard and safety program</td>
<td></td>
</tr>
</tbody>
</table>
6 Example code

The individual functions of the example code are explained in the following Chapters so that you will then be in a position to implement your own project. For this function example, the settings described no longer have to be made.

Note

In this example code, passwords are used for the safety functions. These are as follows:

STARTER Safety Screens: 12345

6.1 Settings in the hardware configuration
6.1.1 Properties of the SINAMICS G120

The window of the SINAMICS G120 PROFIBUS properties (2.) is displayed by clicking once on the SINAMICS G120 icon (1.).

The PROFIBUS telegram (2.) between the CPU and the SINAMICS G120 is the Standard Telegram, in this particular example, Universal module (free telegram configuration) for the communications of the SINAMICS G120 (control signals, status signals, frequency setpoint, frequency actual value etc.)
The telegram is selected in the Catalog after pressing the button.

You can download the GSD files for the SINAMICS G120 under the following link:

GSD files are required to operate a node (e.g. the SINAMICS G120) on PROFIBUS – and to register (log-on) the device to the engineering tool.
Various pre-assigned telegrams and a freely parameterized telegram are available for this communication; these can be selected from the hardware catalog.

The freely parameterizable telegram (Universal module) can be used in this function example. This has the advantage that the telegram structure can be freely adapted to the particular application.

Analog to HW-Config, this telegram selection must also be made in the SINAMICS G120 (refer to Chapter 6.4.5).

1. To parameterize the telegram, first select an Out-input range for I/O Type.

2. and 3. Then, when using the Universal module, the telegram length must be defined for the send and receive directions. In this example, a length of 6 Words is parameterized for sending (Output) and 6 Words for receiving (Input) - from the starting address 256.
6.2 Functions of the Step 7 program

6.2.1 Program overview

The Step 7 program essentially comprises blocks FB10, FC100 and DB1 that are called in the cyclic program (OB1).
6.2.2 **DB1, Axis_DB**

The Axis_DB represents the interface between the S7 program and the SINAMICS G120 via FC100.

Axis_DB is generated from **UDT 1 (Axis_DB_G120)**

**Principal structure of Axis_DB:**

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbolic name</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Internal data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DBW0</td>
<td>Basic_Data.Moduleadress</td>
<td>INT</td>
<td>I/O start address of the SINAMICS G120 (refer to HW Config)</td>
</tr>
<tr>
<td>DBB3</td>
<td>Basic_Data.Drivetype</td>
<td>Byte</td>
<td>Drive type, must be 2</td>
</tr>
<tr>
<td></td>
<td><strong>S7 -&gt; SINAMICS G120</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DBW4</td>
<td>Control_signals.STW2</td>
<td>Bool</td>
<td>Control word 2 (for details, refer to the S7 program)</td>
</tr>
<tr>
<td>DBW6</td>
<td>Control_signals.STW1</td>
<td>Bool</td>
<td>Control word 1 (for details, refer to the S7 program)</td>
</tr>
<tr>
<td>DBW8</td>
<td>Control_signals.Frequency_set</td>
<td>INT</td>
<td>Frequency setpoint in x.x %</td>
</tr>
<tr>
<td>DBW10</td>
<td>Control_signals.Torque_set</td>
<td>INT</td>
<td>Torque setpoint in x.x %</td>
</tr>
<tr>
<td></td>
<td><strong>SINAMICS G120 -&gt; S7</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DBW14</td>
<td>Status_signals.ZSW2</td>
<td>Bool</td>
<td>Status word 2 (for details, refer to the S7 program)</td>
</tr>
<tr>
<td>DBW16</td>
<td>Status_signals.ZSW1</td>
<td>Bool</td>
<td>Status word 1 (for details, refer to the S7 program)</td>
</tr>
<tr>
<td>DBW18</td>
<td>Status_signals.Actual_frequency</td>
<td>INT</td>
<td>Frequency actual value in x.x %</td>
</tr>
<tr>
<td>DBW20</td>
<td>Status_signals.Actual_current</td>
<td>INT</td>
<td>Current actual value (Value from SINAMICS G120)</td>
</tr>
<tr>
<td>DBW22</td>
<td>Status_signals.Actual_current_A</td>
<td>INT</td>
<td>Current actual value in x.xx A</td>
</tr>
<tr>
<td></td>
<td><strong>Error messages</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DBW24</td>
<td>Faults.Drive_error_number</td>
<td>INT</td>
<td>Actual error number of the SINAMICS G120</td>
</tr>
<tr>
<td>DBW26</td>
<td>Faults.Drive_alarm_number</td>
<td>INT</td>
<td>Actual alarm number of the SINAMICS G120</td>
</tr>
</tbody>
</table>

In this function example the individual data of the DB1 are supplied in FB10.
6.2.3 FB10, Organization

This block is called-up in absolute terms in OB1 and in turn calls up FC10.

Principle of the FB10

<table>
<thead>
<tr>
<th>Network</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Calls the FB11 to generate the frequency setpoint</td>
</tr>
<tr>
<td>2</td>
<td>Controls the SINAMICS G120 via the axis-DB, DB1. Calls the SINAMICS G120 control block FC100. Provides the feedback signals – incl. error and alarm number. This network can be used as template for additional SINAMICS G120 control functions.</td>
</tr>
<tr>
<td>3</td>
<td>Controls the signal lamp for &quot;Safety function activated or fault&quot;.</td>
</tr>
</tbody>
</table>

6.2.4 FC100, Control of SINAMICS G120

SINAMICS G120 is controlled using the FC100 via PROFIBUS.

Only signals from the Axis_DB are used to control the block - but no fixed addresses - this is the reason that instances can be used.

This block can be used in the same way for both a standard and a Safety SINAMICS G120.

Formal operands of the FC100

<table>
<thead>
<tr>
<th>Formal operands</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nr_Axis_DB</td>
<td>IN</td>
<td>Number of the Axis-DB generated using UDT1</td>
</tr>
<tr>
<td>Internal_Error</td>
<td>OUT</td>
<td>Displays an internal error 0 = no error 1 = incorrect Axis-DB type (wrong UDT)</td>
</tr>
</tbody>
</table>

Principle structure of the FC100

<table>
<thead>
<tr>
<th>Network</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Opens the Axis_DB specified using the formal operands Nr_Axis_DB. Generates the internal error message.</td>
</tr>
<tr>
<td>2</td>
<td>Reads-in the SINAMICS G120 status words, processes these and saves them in the Axis_DB.</td>
</tr>
<tr>
<td>3</td>
<td>Resets internal error messages.</td>
</tr>
<tr>
<td>4</td>
<td>Converts frequency and torque setpoint from the Axis_DB (entered in x.x %) into the SINAMICS G120 format (hex).</td>
</tr>
<tr>
<td>5</td>
<td>Enters SINAMICS G120 error and alarm number into the Axis_DB.</td>
</tr>
<tr>
<td>6</td>
<td>Sends control words from the Axis_DB to the SINAMICS G120</td>
</tr>
</tbody>
</table>
6.3 SINAMICS G120 - parameterization the safety functions

Refer to Chapter 4.6.2, SINAMICS G120 parameterization

6.4 SINAMICS G120 parameterization

In order that the basic SINAMICS G120 functions can be parameterized, the safety functions in the S7-CPU and in the drive inverter itself must already have been commissioned.

The reason for this is that during parameterization a motor identification routine is carried-out (the motor and cables are measured) - and if vector control is activated - the controller is optimized. Both of these functions require that the safety functions are in the ready state.

6.4.1 SIMATIC Manager - inserting SINAMICS G120

- In SIMATIC Manager select the tree G120_Safety_App_1 and using Insert > Program > SINAMICS select a SINAMICS G120 type object.
- Make the following settings and press the **OK** button.
6.4.2 Calling the STARTER parameterization tool

- Starting from the main path of the SIMATIC Manager, start the STARTER parameterization software by selecting `SINAMICS_G120` and double click on `Inbetriebnahme`.

- Then, in the Project Navigator of the STARTER parameterization software select the object `G120 (1.)` and press button (2.) to establish an online connection to the drive inverter.

6.4.3 STARTER - carrying out quick commissioning

- The screen form with the actual configuration is opened by double clicking on `Configuration` in the Project Navigator.

- The quick commissioning Wizard is started after pressing the `Wizard...` button.

- Enter the appropriate values into the Control structure to Encoder screen forms. You can call-up corresponding help texts in the individual screen forms by pressing on the Help button.
• In the screen form **Drive functions**, select for **Motor identification**, the function **Ident. of al param. in standstill incl. the saturation curve (3)**.

• Enter the corresponding parameters into the **Important parameters** screen form.

• In the screen form **Calculation of the motor data**, select **Restore factory setting and calculate motor data**.

• In the screen form **Summary** do **not** activate the function **RAM -> ROM**, but instead press the **Finish** button.

### 6.4.4 STARTER - carrying out a motor identification routine

• After completing the quick commissioning, alarm **A0541** (Motor data-identification active) is displayed. Please carefully note that when starting the motor identification routine current flows in the motor. For hanging (suspended) axes the load must always be supported.

• To start the motor data identification routine, in the Project Navigator select the menu item **Commissioning** and activate by double clicking on **Control panel**.

• Press **Assume control priority** and carefully note the security/safety information and instructions. Then activate **Enables**.

• **1.)** If the Control panel isn't completely displayed on your PG/PC, then press the **button**.

• The motor data identification routine is started by pressing the **button. Do not exit the STARTER software and go to another task as otherwise the motor data identification routine will be interrupted for safety reasons.

• Please wait until the **button changes back to the **button.**
6.4.5 STARTER - setting the Profibus communications

- Communications between the CPU and the SINAMICS G120 must then be parameterized. To do this, open the screen for the communication settings using Communication -> Profibus. Select the tab Transmit direction.
- To start, select the Standard-Telegram 350 (350) from Message frame: (1.). This pre-assigns the telegram.
• Then replace telegram 350 by telegram type Free BICO connection (999) (1.).
  Deactivate any possibly active Suppress inactive interconnections function (2.) and establish the following interconnections (3.):
  • PZD 5 = r2131 (Last fault number code)
  • PZD 6 = r2132 (First warning number code)

• Finally, you only have to save the SINAMICS G120 configured software in the ROM memory of the drive inverter. To do this in the Project Navigator select the menu item SINAMICS_G120

• In the function bar press the button.
• Please wait until the download operation has been completed.
7 Evaluation according to IEC 62061 and ISO 13849-1

With this function example two Safety Evaluation Tool projects for each standard are provided.

IEC 62061: SD_FE_I_002_V20_EN_IEC.set
ISO 13849-1: SD_FE_I_002_V20_EN_ISO.set

Link to the Safety Evaluation Tool:
www.siemens.com/safety-evaluation-tool
8 Appendix

8.1 Reference data

This list is in no way complete and only reflects a selection of suitable references.

<table>
<thead>
<tr>
<th>Subject area</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application sample</td>
<td>Safety INTEGRATED</td>
</tr>
<tr>
<td></td>
<td>Order-No.: 6ZB5310-0MK01-0BA2</td>
</tr>
</tbody>
</table>

8.2 Internet link data

<table>
<thead>
<tr>
<th>Subject area</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to safety items</td>
<td><a href="http://support.automation.siemens.com/WW/view/en/20810941">http://support.automation.siemens.com/WW/view/en/20810941</a></td>
</tr>
<tr>
<td>SINAMICS G120</td>
<td>Documentation</td>
</tr>
<tr>
<td>Siemens customer</td>
<td>Customer Support</td>
</tr>
<tr>
<td>support homepage</td>
<td></td>
</tr>
<tr>
<td>Safety integrated</td>
<td>Safety Integrated</td>
</tr>
<tr>
<td>homepage</td>
<td></td>
</tr>
<tr>
<td>SINAMICS G120</td>
<td>Homepage</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.automation.siemens.com/sd/sinamicsg120/index_00.htm">http://www.automation.siemens.com/sd/sinamicsg120/index_00.htm</a></td>
</tr>
<tr>
<td>Safety Evaluation Tool</td>
<td><a href="http://www.siemens.com/safety-evaluation-tool">www.siemens.com/safety-evaluation-tool</a></td>
</tr>
</tbody>
</table>

8.3 History

<table>
<thead>
<tr>
<th>Version</th>
<th>Datum</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>October 2006</td>
<td>First edition</td>
</tr>
<tr>
<td>V2.0</td>
<td>June 2010</td>
<td>General reworking of the document</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Changeover to firmware V3.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Expanded functionality for evaluation according to IEC 62061</td>
</tr>
</tbody>
</table>
8.4 Evaluation / feedback

I DT MC PMA APC
D-91506 Erlangen

Fax.: 09131 98 – 1297
Mail: Online-support.automation@siemens.com

<table>
<thead>
<tr>
<th>Sender</th>
<th>If you came across errors when reading this document please let us know using this form. We'd also be thankful for any suggestions and recommendations for improvement.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td></td>
</tr>
<tr>
<td>Department:</td>
<td></td>
</tr>
<tr>
<td>Location:</td>
<td></td>
</tr>
<tr>
<td>Telephone:</td>
<td></td>
</tr>
<tr>
<td>Internet address:</td>
<td></td>
</tr>
</tbody>
</table>

Evaluation of the function example

Extremely good □  Good □

Not so good □  because

Subject of interest □  Subject not interesting □

Scope sufficient □  Too detailed □  Too superficial □

Understandable □  Sometimes understandable □  Not understandable □

Good layout □  Average layout □  Poor layout □

Often used □  Infrequently used □  Used only once □

Time saving by using the document when compared to before:
No time saving □  approx. 5% □  approx. 10% □  other .......... %

Suggestions:

.......................................................................................................................................................

.......................................................................................................................................................